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A letter to the desk of the editor to letter from editor's desk 

The sketchup-ur-space editorial team has published another exciting issue enriched with some 
in-depth articles and useful tutorials for global sketchup enthusiasts. This issue will also be a 
great resource for sketchup users. Besides, articles and tutorials, this edition comes up with 
latest news and happenings in sketchup. 
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In every issue, our editorial team gives their best effort to make the magazine more informative 
and interesting for the readers. 

In the cover story of this edition, Henry Gross, the founder of architectural visualization studio, 
has shared his professional experience for transforming the architectural visualization process to 
the next level by integrating architectural basics into his elaborate, detailed presentations. He 
briefly explains the significance of an architecture background for producing stunning 
visualizations. 

In the Article section, the readers will get detail information about three newest sketchup 
extensions alias AutoSmooth extension developed by Thomas Thomassen, Drop Vertices 
Extension developed by TIG, SketchFX developed by Fluid Interactive. In another article detail 
analysis is provided on skethup move tool. 

AutoSmooth extension is used to make autofolded edges smooth and soft which are produced 
by native move, rotate and scale tools. 

The Drop Vertices Extension is used to maneuver terrain borders or align edges to objects in 
sketchup. 

SketchFX Ex for sketchup facilitates the users to export static images from sketchup and post 
process in photoshop inside sketchup view port. It embellishes your 3D creations visually 
appealing from bloom effects to colour corrections. 

The article on move tool provides details about direction and distance. While moving an entity in 
sketchup, a direction and distance known or unknown is provided. Sometimes, the users exactly 
identify the specific direction and distance to move and provide that input to SketchUp by typing 
it in. Other times, the users provide the direction and distance by inferencing other points in the 
model. 

In Tips and Tricks section, the readers will get brief insight about axes tools in sketchup (Axes 
Tools is a small utilty that reset the axis of components to their bounding box' centre or corners), 
some vital tips to design models for 3D printing (these tips will allow the users to create the 
design of prototypes for 3d printing as well as design their own objects which interact with 
phone, remote, camera, or any other object), review of some vital sketchup extensions for 
architectural workflows (an wide array of lists for useful sketchup extensions) and 8 important 
tips to navigate Model Interiors in SketchUp (Learn some useful tricks to model interior in 
sketchup easily and quickly) . 

The Blog section sheds light on 1) how to add background images into sketchup efficiently, 2) 
some vital guidelines for beginners sketchup users to start modeling with sketchup; 3) Some vital 
tips on sketchup freehand tool to produce freehand shapes and hand-drawn lines 4) Some 
leading websites to acquire different types of materials and textures for creating stunning 3d 
rendering and modeling. 
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The news section covers some vital topics like 1) Creating Wall Cost Estimates in SketchUp with 
Quantifier Pro; 2) Details of some 3D Warehouse Tools from SketchUp Extension Warehouse; 3) 
Methods to model Terrain and Other Rounded Shapes 4) Texturing an Arch in SketchUp using 
ThruPaint. 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

Review of AutoSmooth Extension in SketchUp 
 

AutoSmooth is one of the amazing 

extensions invented by Thom Tom 

which automatically softens and 

smoothes autofolded edges. 

The SketchUp Extension Warehouse 
is full of tools that enable users to 
review the model of users such as 
nested groups, model size and 
remove any unnecessary lines, marks 
etc. before uploading the model into 
3D Warehouse. 

About Extension Warehouse: 

It is an online resource with various 
plug-ins developed made especially 
for SketchUp and these extensions 
help to add some special tools and 

Best wishes 

RAJIB DEY 

Editor 

For any feedback and query please send mail to 

rajib@jobs2india.com 
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features to SketchUp. These extensions can be found for any particular application like drawing 
or 3D printing and some industry specified tools for architecture, interior design, construction 
and many more. So basically in this Extension Warehouse people can do the following things:\ 

 Users can search extensions by name or as per the functionality. 

 They can also install various extensions with a single click of a button. 

 Or users can also control all the extensions from easy-to-use location in the My Extension page. 

About Thom Thom: 

Thomas Tomassen is actually known as Thom Thom, he is a modelmaker with a large desire for 
physical, digital and traditional design in most kinds of the trade. He is also focused on web 
design or programming and 3D visualizations but he is specialist in 3D modeling, SketchUp, 
Web design, graphic design and web programming. 

AutoSmooth 

AutoSmooth extension by Thom Thom can automatically soften and smoothes autofolded 
edges which are made by the native Move, Rotate and Scale Tools. It works in the background 
as a representation of autofolding feature. He made this extension to make sure that every 
little object is made in SketchUp will be created with smooth edges automatically so that users 
don’t need to work on them again. 

Path 

View > Toolbars > AutoSmooth 

Requirements 

TT_Llb2-2.7.0 

 

Source: www.extensions.sketchup.com 

 

 

Review of Drop Vertices Extension in SKetchUp 

TIG’s Drop Vertices extension in SketchUp can be perfectly used while manipulating terrain 
borders or align edges to objects in SketchUp. 

The SketchUp Extension Warehouse is full of tools that enable users to review the model of 
users such as nested groups, model size and remove any unnecessary lines, marks etc. before 
uploading the model into 3D Warehouse 

http://www.extensions.sketchup.com/
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About Extension Warehouse: It is an online resource with various plug-ins developed made 
especially for SketchUp and these extensions help to add some special tools and features to 
SketchUp. These extensions can be found for any particular application like drawing or 3D 
printing and some industry specified tools for architecture, interior design, construction and 
many more. So basically in this Extension Warehouse people can do the following things: 

o Users can search extensions by name or as per the functionality. 

o They can also install various extensions with a single click of a button. 

o Or users can also control all the extensions from easy-to-use location in the My Extension page. 

 

Vertex Tools generally take control 
over each vertex editor for 
SketchUp. The soft selections are 
an immediate for organic modeling 
and the manipulator gizmo gives 
the users great control while 
modeling. While, Drop Vertices 
extension drops/Moves edges’ 
vertices to different positions. 

In this article we will learn to use 
TIG’s Drop Vertices extension in 
SketchUp which can be perfectly 
used while manipulating terrain 
borders or align edges to objects in 
SketchUp. 

Drop Vertices extension can mainly 
be used when users want to soften the edges of a terrain. At first, users need to select the 
boundary edges of the terrain and need to go to the Extension menu in SketchUp to select 
Drop Vertices. After selecting this menu, it will show the nearly image which has zero value. 
Actually there are too many options to choose from the Drop Vertices option like showing a 
below edges image of the actual terrain or showing an up edge image of the actual one. So 
basically, Drop Vertices menu has several options that can be applied upon any terrain to give 
it a new ace. 

Source: www.sketchucation.com 

 

 

http://www.sketchucation.com/


 
 

                           8 | P a g e  
 

Review of SketchFX Ex for SketchUp 

 

SketchFX Ex for SketchUp helps to give the same result directly within the SketchUp viewpoint 
and using the same layering approach as Photoshop, it utilizes a smart approach to stacking 
effects. 

SketchFX: It applies a series of visual effects one after another in a bottom down order and it 
has three types of effects: Image, Filter and Mask. 

The difference of SketchFX with other photo editing software is that it includes some combined 
effects that help to give a neat look in the model and more than that, each of these items in 
the list can be individually on and off to put effects. The items have more individual actions in 
their drop down options which can be named later and each individual will put an effect on the 
model, it is a fun thing to do. People can also apply various effects in a time and all of them will 
show clearly on the model without any mess which is a huge progress of this software. It also 
helps to show some details of mechanic drawings, though SketchFX misses some extra details 
but also adds some other information in the model which can’t be found anywhere. SketchFX is 
an easier way to show and change different details of a model. 

We have discussed about SketchFX Ex in the last article where we found the name of SketchFX 
Ex which has all the features of SketchFX Pro and adds support of rendering animations. In this 
article, we will know more about it. 

About SketchFX Ex: Similar like SketchFX, it is an artistic rendering solution for SketchUp. 
SketchFX Ex is pretty similar to Piranesi except it all works directly in the SketchUp viewpoint. It 
adorns 3D creations with visual enhancements from bloom effects to color corrections. It is 
kind of a shortcut to create compelling illustrations from models in SKetchUp and achieves all 
this with one-click using out the box presets. 

Method of work of SketchFX Ex: In this tool, each effect is build and blended over the next; the 
ranges of effects can be mixed together are quite extensive. Though it is bewildering, but after 
spending a little time reverse engineering the default presets users quickly become more 
known with the process. For breaking it down a little more the effect stack can be divided into 
4 parameters. Image adjustments are managed using Hue, Saturation and Value, 
Brightness/Contrast and Exposure filters. Image improvements are managed though Bloom, 
Blur, Vignette, Paint and Depth of Field filters. Image layering can be made using additional 
images of scene images and SketchUp Styles. After that, users can use various masks to target 
these layered effects. 
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Certain effects can 
have a parent-child 
relationship to the 
previous effect which 
allows targeting a 
specific effect on 
specific properties. 
Users can set SketchUp 
Line Style to be blurred 
and overlayed over 
another effect rather 
than globally blurring 
the scene. Basically, 
one of the strongest 
features of SketchFX Ex 
is the ability to overlay 
SketchUp Styles, 
external images and 
other scenes. 

Benefits of having SketchFX Ex: It is a very good option for the people who can use it. Even with 
the default presets users get wonderful results. The newcomers to image editing can have a 
steep learning curve ahead. The actual way of creating own effects are very easy, the rendering 
times are fully dependent on the amount of effects to be applied and the computing input of 
that effect. The UI though is not the most approachable aspect of SketchFX as there are many 
toggles, sliders and dropdowns to contend with but it is clear what each option does. While the 
utter depth of option adds a labor intensive layer to create illustrations can save custom 
creation to file for re-use in other projects. So, SketchFX Ex is like a StyleBuilder for SketchUp, a 
standalone image enhancer for presentations but it is not a toll for novices as users need to 
spend a lot of time in Photoshop beautifying SketchUp output this could save a tone of time. 
SketchFX Ex is like a medium between not quite the SketchUp look and not the photoreal 
rendering look. It is aimed primarily at professionals who want to sell the sizzle of their designs. 

Final words: Basically, SketchFX Ex is a very strong illustration tool for SketchUp but users need 
to know their preferences which will deliver impressive results with the default presets. But 
after spending time with SketchFX, users can be a pro in it. 

Source: www.sketchucation.com 

Review of Two inputs for the Move tool 

Move tool in SketchUp has two things which help to move an entity in an easy and natural way. 
Users can use it without or with knowing the direction and distance 

https://sketchucation.com/all-news/reviews/1998-sketchfx-for-sketchup-review
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SketchUp’s Move tool is a very natural and easy way to use but there are two things in 
SketchUp which are essential while moving an entity. After identifying those two things in 
SketchUp, users can unlock even more flexibility while moving things in SketchUp. 

The two essential things which are needed to move something in SketchUp are: 

Direction: With direction, users don’t need red, green or blue axis. 

Distance: It help to measure how far along the directional axis are the entities being moved. 

Every single time while moving an entity in SketchUp, users will be given a direction and 
distance. Sometimes, users will know the specific direction and distance they need to move 
and provide hat input to SketchUp by typing it. If not, then SketchUp will provide a direction 
and distance by inferencing other points in the model. 

Here are two scenarios described with their following steps: 

Known Direction and distance: If the distance and direction is known by the user then the 
following steps are helpful: 

 At first, users need to select the entities that need to move with the Select Tool. 
 Then users need to activate the Move tool. 
 Next they need to click once to start the move. 
 Then they need to tap the Right Arrow Key to identify the direction. 
 At last, they need to enter the known direction to identify the distance. 

*here the users don’t need to click on any particular point in the model or on the entity the 
need to move as long as the entity is preselected. 

Unknown Direction and distance: There are sometimes, when users don’t know the distance 
or direction that needs to move so here users have to rely on snapping to points in the model 
to define both of those inputs. 

o At first, users need to select the entities that they need to move with the Select tool. 
o Then need to activate Move tool. 
o Next users need to hover over and snap to the first point on the object. Just click to start the 

move from the point. 
o At last, users need to snap to last point or where they need to align to and click to finish the 

move. 
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Known 
Direction and 

unknown 
distance: Unlik

e the other 
two, there may 
be other 
situations also, 
where users 
want to move 
an object along 
a specific 
location, to an 

unknown 
distance. Tape 
Measure tool 
can be used to 
figure out the 

distance. 

o At first, users need to select the light with the Select tool. 
o Then activate the Move tool. 
o Next Snap to the midpoint of the object need to move and click starts the move. 
o Then tap the Right Arrow key to define the direction along the red axis. 
o At last, move the mouse to the midpoint of the column. 

Aligning objects: Another very common move workflow is aligning objects along each of the 
three axes; one at a time which makes it much easier to move as users can lock the direction 
during each step and only have to think about is the distance along each axis. 

o At first, users need to select the object with the Select tool. 
o Then need to activate the Move tool. 
o Next they need to click on a point on the object that needs to make a plane with 

another point or face in the model. 
o Next, they need to tap the arrow key to define the direction along that axis. 
o Then need to snap to the edge that needs to be in plane with and click to finish. 
o This process need to repeat on each axis. 

Source: www.mastersketchup.com 

 

http://www.mastersketchup.com/
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Creating Wall Cost Estimates in SketchUp with Quantifier Pro 

 
Quantifier Pro is an essential tool 
for creating cost estimates in 
SketchUp. Users can use this 
extension to estimate the exact 
cost of the walls. 

In this article we are going to 
discuss about Quantifier Pro tool 
in SketchUp through Geis’s 
tutorials and here are some 
information about this tool. 

Quantifier Pro: SketchUp 2016 
or the newer version is suitable 
for Quantifier Pro and it is also 
compatible with both Mac and 
PC. This is the ultimate tool to 
get instant quantity and cost 
information from the SketchUp 
model. It has various features 
like: 

o Selecting the objects in the model will instantly show the total length, area, volume, 
weight and cost 

o After using the model all the reports are model-driven and automatically update while 
the model will change. 

o Fully Customizable Component Reports are found there which will show length, width, 
height, projected area, surface area, volume, weight, cost and many more things. 

o There are also detailed cost reports. 
o Instant Material Report will show the surface area of all materials in the model 
o Assign re-usable cost rules are shown by layer, material, object or to the whole model 
o Cost Inspector tool will show total cost calculation for the selected object to verify 

accuracy 

 

NEWS 
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o In Windows, Microsoft Excel is used to share unified cost data across many SketchUp 
models 

o This extension also supports many languages and international currency 
o There are full control of units and accuracy shown in reports 
o If Profile Builder 3 is added with this extension, then it will be even more colorful. 

This Plugin cost $79 alone and if it is bundled with Profile Builder 3 then it will cost 25% off of 
each extension 

Estimating Wall costs with Quantifier Pro: This particular extension is designed to help in 
quantifying and price in different things within the SketchUp models; at first the users have to 
select different objects within the model and then apply cost data to them within quantifier. 
Within quantifier, users can select different objects and can be viewed within the quantifier 
dialog. It should be kept in mind that while using quantifier, users have to put the objects on 
the same material on their own layers; as an example if one is going to quantify a block wall 
then he/she will try to put all the block wall objects on a block wall layer. After this, this 
extension will allow the users to apply various cost properties to the objects on the layer. 
Moreover that, this extension can be used to apply costs to objects by other units within the 
model like length; and it also works with profiles that have not been created with Profile 
Builder or by the users themselves. Users can also apply costs based on SketchUp materials 
also and this will calculate the cost based on materials that have been applied to front side 
faces only to avoid double counting back side materials. It is also possible to directly overrule 
the cost added with an object using the object opinion and while modeling an object that are 
punching a bunch of holes it; then it is better to model that as standard geometry rather than a 
profile builder assembly as they actually calculates using the bounds of an object. Finally 
besides all of these one can create reports within quantifier that can either viewed within 
SketchUp or can be exported to Excel, theoretically one an import cost data from an Excel 
spreadsheet also. 

Wall costs estimation process follows same procedure as creating any type of cost estimation 
in SketchUp but here users can create some walls in their model and can estimate the cost by 
following the exact processes shown by Justin in his tutorial video. Justin has estimated costs 
within two mwthods, the first one is made without using Quantifier Pro and Profile Builder 
while the second one has both init. 

Source: www.thesketchupessentials.com 

 

 

 

http://www.thesketchupessentials.com/creating-wall-cost-estimates-in-sketchup-with-quantifier-pro/
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Details of some 3D Warehouse Tools from SketchUp 
Extension Warehouse 

 

 
SketchUp Extension Warehouse 
has some quality check tools 
that help to review every little 
things of the model of users and 
help to remove unnecessary 
things before uploading the 
model. 

The SketchUp Extension 
Warehouse is full of tools that 
enable users to review the 
model of users such as nested 
groups, model size and remove 
any unnecessary lines, marks 
etc. before uploading the model 
into 3D Warehouse. 

About SketchUp: SketchUp or 
Google SketchUp is owned by Trimble Inc., a mapping, surveying and navigation company. It is 
mainly a 3D modeling computer program that is used for a broad range of drawing applications 
used by architects, interior designer, landscape architects, civil and mechanical engineers, film 
and video game designers also. It SketchUp can be getting as a freeware version named 
SketchUp Make and a paid version with many more extra benefits called SketchUp Pro. 
SketchUp is software from Trimble Company and there is an online library of free model 
congregations and 3D Warehouse to which users can add other models; besides that, the 
program has drawing layout functionality with variable ‘styles’, supports third-party ‘plug-in’ 
programs hosted on the Extension Warehouse to supply other abilities and enables placement 
of its models in Google Earth. As SketchUp users are most of architects, designers, builders, 
makers and engineers etc. 

who works hard to give a nice shape to our physical world, they need great tools to do the 
work. SketchUp is in mission to bring their best to produce some great tools for drawing as 
drawing is the key thing of the SketchUp users. They draw to search ideas, to identify the 
things and to show other people their work that they do with love and love to build; SketchUp 
understands it truly and trying to improve their software day by day. SketchUp is a worth 
useful software for its ease of use, it can be downloaded or installed o computer and right after 
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that user can work on it. Though SketchUp can easily handle but still there are some sides 
where people will find some difficulties and lots of solve also are there like YouTube tutorials 
upon SketchUp or visiting SketchUp website or search Google etc. But people will get confused 
to have lots of information from different places upon one thing so there should a proper place 
or website where all the answers can be found. 

Here are the details of some tools: 

o Show Nesting Levels: It is a visual way of testing the structure of a selection or the whole 
model. This tool creates a layer for every nesting level that is found in the selection and sets 
the model display to Color by layer. The layers use ordinary AutoCAD colors like red-1, yellow-
2, green-3, cyan-4, blue-5, magenta-6, and silver-7. 

o Save Screen Image: This tool allows users to notate the model directly in SketchUp, then catch 
the screen as a jpg file for communication and further analysis. It also saves the image in the 
same folder as the model and at any time through the review, they are numbered 
consecutively for users. 

o Model Report: Users can use this tool to view information about the selection or the entire 
model. The Top Level information shows users the number of components and groups at the 
first level when editing the component. The second half of the report shows the whole polygon 
count which is very 

o Quick Check: This is a menu item that counts all the needless elements in the model based 
upon the 3D Warehouse checklist and highlights them for visual inspection. 

o Count Stuff: This menu items allows users to count just one type of element in the model and 
can highlight it for users also. 

o 3D Warehouse Cleaner: This tool allows users to decide which things to remove from the 
model based upon the 3D Warehouse checklist. The default is all items. Users will have a 
summary and can see all the items disappear from each dialog, simplifying the model. 

Source: www.extensions.sketchup.com 

 

Methods to model Terrain and Other Rounded Shapes 

 
3D modeling has become better and easier after using SketchUp, users can also model Terrain 
and Other rounded shapes in SketchUp using Sandbox Tools. 

https://extensions.sketchup.com/en/content/3d-warehouse-tools
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Terrain is important thing for many modelers in SketchUp who wants to create a ground to 
stand on or modeling the ground itself to create a landscape. Terrain can be made by using 
SketchUp’s Sandbox tools, but it also can create forms completely unrelated to terrain. 
Though, terrain can include in all these other possibilities because the secret is hidden in the 
geometry. That’s mean, while modeling terrain or other shapes with Sandbox tools users 
actually sculpting a special kind of 
geometry called a TIN (triangulated 
irregular network) which generally mean 
“a group of comprised of triangles” . 

In this article, we are going to describe the 
way of start modeling TINs, the path 
to find Sandbox tools and tell about 
geolocate TIN. 

Getting started with TINs: For 
creating TIN, users can import contour 
lines from another program or 
import terrain from Google Earth 
through SkethcUp’s built- in tools. Users 
can also transform contour lines which are 
drawn into a TIN or may draw a plain 
flat rectangular TIN. After having a TIN in SketchUp users can toggle terrain between visible 
and hidden with SketchUp’s layer feature as controlling visibility is the whole reason of layers. 
After creating or importing terrain, it must be made sure that all the terrain geometry is 
organized into a single group and then assign that group to layer to control the visibility of 
terrain. The next step is to sculpt and fine-tine its features by smooving gills and valleys, 
detailing terrain and flipping edges. The last step is to place other items on its surface. 

Enabling the Sandbox tools: To find the Sandbox tools users need to go on the Sandbox 
toolbar or select Tools>Sandbox and select the tool of choice from the submenu. In SketchUp 
Pro, the Sandbox Tools are enabled by default. While in SketchUp Make, users also have access 
to the Sandbox Tools but it needs to be enabled at first. 

Geolocated Terrain: While modeling terrain, users can geolocate it or embed geographical 
coordinates that place terrain at a specific point on the Google Earth. There are a huge number 
of advantages in the Geolocated models, such as: 

o It can study the sunlight and shadows at different times of day and on different days of the 
year and they both have huge benefits like shadow studies can tell users about if adding a 
second story in the house will turn a sunny garden patch into a shady place or not. Users can 
also get an idea of how the sunlight shines into an interior space at different times of day. 
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o Users can view their models in Google Earth which comes in both free and paid versions that 
can be downloaded to the computer and it is full of aerial imagery and models. So users can 
view the model on the site where users plan to build it. 

Source: www.help.sketchup.com 

 

Texturing an Arch in SketchUp using ThruPaint 
 

Fredo’s ThruPaint is used to texture an Arch using 
its QuadMesh UV feature and this technique is 
particularly useful for Architectural models which 
reflect the real world construction. 

SketchUp is full of tools and extensions, all these 
extensions are found in the Extension Warehouse of 
SketchUp. FredoTools groups have a number of 
standalone plugins and come as a single package. It 
reduces the footprint on SketchUp and avoids 
individual installation of each plugin in it. 

In this article, we are going to discuss about the method of using Fredo’s ThruPaint to texture 
an arch using its QuadMesh UV feature. This technique is only useful for Architectural models 
that reflect the real world construction using only a texture. 

ThruPaint is a plugin for SketchUp that expands the native SU Paint tool with some functions 
like painting across the boundaries of components and groups, control of the faces and face 
side, texturing with continuity and texturing edition. It can be found in SketchUcation. 

o First things first: But at first, users need to install both FredoTools 2.9 and LibFredo 6.9 into 
SketchUp from SketchUp’s Extension Store directly. After installing them, users can access 
ThruPaint via Tools > FredoTools > ThruPaint or via FredoTools toolbar. For adding a dedicated 
ThruPaint icon to SketchUp users need to go to Tools > FredoTools > Default Parameters and 
under the option “Icons Visible in the Toolbar” they can select ThruPaint option. It will set the 
icon on SketchUp starting window so user can use it directly from there. 

o The topology needed to properly texture in SketchUp: While beginning the work, user will need 
the geometry to be compliment with ThruPaint QuadMesh UV method. Every face of the arch 
must be a quad for ThruPaint for applying the texture in a right way. 

o Setting ThruPaint to paint QuadMesh UVs: After activating ThruPaint the on screen options 
need to be set for painting the mesh correctly. If users hover over a face in SketchUp, they can 

https://help.sketchup.com/en/sketchup/modeling-terrain-and-other-rounded-shapes
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see ThruPaint highlight one edge Green and the other Red, it is very important as this is related 
to the orientation of the texture. 

o Painting and editing textures with ThruPaint: This extension is used to paint the texture and 
the option ‘All Connected Faces’ is selected so, ThruPaint will align the texture correctly. If 
manipulating the texture is needed further then users can click the surface again to enter 
Visual Edit mode. The Visual Editor of ThruPaint allows scaling, rotating and translating 
textures interactively in SketchUp by dragging tool for SketchUp on the right handle. 

Finally it can be said from the upper discussion that ThruPaint is a wonderful texture mapping 
tool for SketchUp which is also easy to use. 

Source: www.sketchucation.com 

 

 

 

 

 

 

 

Details of Axes Tools in SketchUp 
 

 

Axes Tools is a small utility that reset the axis of components to their bounding box centre or 
corners and can be found in the SketchUp Warehouse. 

About SketchUp: SketchUp or Google SketchUp is mainly a 3D modeling computer program that is 
used for a broad range of drawing applications used by architects, interior designer, landscape 
architects, civil and mechanical engineers, film and video game designers also. SketchUp can be 
getting as a freeware version named SketchUp Make and a paid version with many more extra 
benefits called SketchUp Pro. SketchUp is software from Trimble Company and there is an online 
library of free model congregations and 3D Warehouse to which users can add other models; 
besides that, the program has drawing layout functionality with variable ‘styles’, supports third-
party ‘plug-in’ programs hosted on the Extension Warehouse to supply other abilities and enables 
placement of its models in Google Earth. As SketchUp users are most of architects, designers, 
builders, makers and engineers etc. who works hard to give a nice shape to our physical world, they 
need great tools to do the work. SketchUp is in mission to bring their best to produce some great 
tools for drawing as drawing is the key thing of the SketchUp users. They draw to search ideas, to 
identify the things and to show other people their work that they do with love and love to build; 
SketchUp understands it truly and trying to improve their software day by day. SketchUp is a worth 

 

TIPS & 
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http://www.sketchucation.com/
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useful software for its ease of use, it can be downloaded or installed o computer and right after 
that user can work on it. Though SketchUp can easily handle but still there are some sides where 
people will find some difficulties and lots of solve also are there like YouTube tutorials upon 
SketchUp or visiting SketchUp website or search Google etc. But people will get confused to have 
lots of information from different places upon one thing so there should a proper place or website 
where all the answers can be found. 

SketchUp Warehouse has various extensions and plugins that allow the users to design quickly and 
accurately and like all other extensions, Axes tools can be used to bulk reset of group and 

components axes. 
This article is going 
to discuss about 
another tool named 
Axes Tools which is 
used less by users. 

About Extension 
Warehouse: It is an 
online resource with 
various plug-ins 
developed made 
especially for 
SketchUp and these 
extensions help to 
add some special 
tools and features to 
SketchUp. These 
extensions can be 
found for any 

particular application like drawing or 3D printing and some industry specified tools for architecture, 
interior design, construction and many more. So basically in this Extension Warehouse people can 
do the following things: 

o Users can search extensions by name or as per the functionality. 

o They can also install various extensions with a single click of a button. 

o Or users can also control all the extensions from easy-to-use location in the My Extension page. 

About Thom Thom: Thomas Tomassen is actually known as Thom Thom, he is a modelmaker with a 
large desire for physical, digital and traditional design in most kinds of the trade. He is also focused 
on webdesign or programming and 3D visualizations but he is specialist in 3D modeling, SketchUp, 
Webdesign, graphic design and web programming. 
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Axes Tools: It is actually has a small utility that reset the axis of components to their bounding box 
centre or corners. This is useful for them who imports pesky DWG files where the insertion point of 
the blocks are too far that makes components jitter. 

Menus and Toolbars: Plugins > Axes Tools 

Requirements: SketchUp 7 or Newer, TT_Lib2 (v2.2.0) 

Source: www.extensions.sketchup.com 

 

 

 

14 tips to design models for 3D Printing 
 

 

Nowadays 3D modeling is a famous way to represent works but while using 3D printer to print 
models, users need to 
follow little tips for 
better modeling. 

3D printing or additive 
manufacturing is way 
of making three 
dimensional solid 
objects from a digital 
life. The creation or 
making of a 3D printed 
object is achieved 
using additive 
processes and in this 
process, an object is 
made by laying down 
successive layers of 
material till the object 
is created. Each of 
these layers can be 
visible as a thinly sliced 
horizontal cross-

section of the eventual object. So basically 3D printing is the opposite of subtractive 
manufacturing which is cutting out a piece of metal or plastic with for specimen a milling 
machine. 

http://www.extensions.sketchup.com/
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Owning a 3D printer, everyone wants to model something new and excellent but there are 
some tips that can make your works easier and these tips can be applied on every 3D printing 
project. Most of the tips can be used with any 3D modeling software, not just SketchUp and 
they will surely save time, model more accurately, create a stronger model and reduce 
warping. 

Here are the tips for modeling a project in a 3D Printer in a better way: 

1. Research previous models: The first step of every modeling is to do some research while 
working on any software to find out designs before working on it. The purpose of searching 
for existing models is to reduce the time of making a model twice and also it will help to 
reverse about the model or help to know some new improvement to create a model. 

2. Start with one profile: it is advisable and better not to work on entire model at a time, 
always identify the critical parts that need multiple iterations and then go on. It will help to 
create a model in a clear way and the work will complete faster. 

3. Brackets are required: To take the perfect measurement of any object, calipers or brackets 
is needed which allow users to take interior, exterior and depth measurements very 
perfectly. 

4. Use paper to model profiles: It is very important to get an accurate model of a real life 
project into a 3D modeler but it is also difficult that’s why it is way better to design the 
rough idea on a paper before the final project. 

5. Planning the orientation of model: The orientation of a model is critical so it is better to 
have a rough idea of the shape of model before starting. 

6. Taller layers save time: With these early prototypes, using a larger layer height while 
printing can help to print faster. 

7. Use straight lines when possible: If it is possible, use straight lines as they will help to make 
changes. 

8. Always save copies of model at different stages: Saving design at its different phase and 
creating a copy of the component help to keep a record of the design process that can be 
useful later. 

9. Create a rough model of the attached object: It is a good idea to add a rough model of the 
object hat need to be attached as it will help to make the model perfect. 

10. Integrate other models in project: Sometimes users can import the model and join it to the 
existing model which will be a reference. 

11. Test the prototype: After printing out the model, it needs to be tested thoroughly as it will 
help to change or add something in the model before the final outcome. 

12. Round corners on final model: After creating a final model, make sure to round the corners 
of the model which will remove sharp edges and give the model a smooth finish. 

13. Add breaks on the bottom layers: One of the challenges of 3D printing is wrapping which 
occurs when the bottom layers of the print cool faster than the top ones. Adding physical 
breaks in the model will help to reduce the speed. 
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14. Add reliefs in the middle: Having a model with a large surface area on the bed, users need 
to try raising some areas up a few millimeters to reduce the amount of filament on the first 
few layers. 

Source: www.mastersketchup.com 

 

 

 

Review of 5 most helpful extensions for architectural workflows 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SketchUp Extensions make the 3D modeling in SketchUp easier than before and there is a huge 
list of extensions in the Warehouse, but there are 5 top most useful extensions to work with. 

https://mastersketchup.com/14-tips-for-designing-prototypes-for-3d-printing/
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SketchUp Extensions are wonderful and help users to speed up the workflow but there are a 
huge number of extensions found in the SketchUp Extension Warehouse and for a beginner it 
become little difficult to find out which ones help most. This choice is based on workflows. 

In this article we are going to talk about a list of helpful extensions that have used multiple 
times in the SketchUp community. 

About SketchUp: SketchUp or Google SketchUp is mainly a 3D modeling computer program 
that is used for a broad range of drawing applications used by architects, interior designer, 
landscape architects, civil and mechanical engineers, film and video game designers also. 
SketchUp can be getting as a freeware version named SketchUp Make and a paid version with 
many more extra benefits called SketchUp Pro. SketchUp is software from Trimble Company 
and there is an online library of free model congregations and 3D Warehouse to which users 
can add other models; besides that, the program has drawing layout functionality with variable 
‘styles’, supports third-party ‘plug-in’ programs hosted on the Extension Warehouse to supply 
other abilities and enables placement of its models in Google Earth. As SketchUp users are 
most of architects, designers, builders, makers and engineers etc. who works hard to give a 
nice shape to our physical world, they need great tools to do the work. SketchUp is in mission 
to bring their best to produce some great tools for drawing as drawing is the key thing of the 
SketchUp users. They draw to search ideas, to identify the things and to show other people 
their work that they do with love and love to build; SketchUp understands it truly and trying to 
improve their software day by day. 

About Extension Warehouse: It is an online resource with various plug-ins developed made 
especially for SketchUp and these extensions help to add some special tools and features to 
SketchUp. These extensions can be found for any particular application like drawing or 3D 
printing and some industry specified tools for architecture, interior design, construction and 
many more. So basically in this Extension Warehouse people can do the following things: 

o Users can search extensions by name or as per the functionality. 

o They can also install various extensions with a single click of a button. 

o Or users can also control all the extensions from easy-to-use location in the My Extension page. 

1. 1001 Bit Tools: It is a Freeware with an upgraded professional version. 1001 Bit Tools is a 
group of tools that simplify the drawing of geometry associated with drawing a structure in 
3D. 

2. Profile Builder: Profile Builder tool can be used to draw any type of walls, railings or 
fences. After release of the new version 3, Profile Builder can be schemed “Follow Me” on 
steroids which allows users to put together arrays of geometry that are copied along the 
stretch of a user-defined path. 
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3. Framer: Though framing is not used often in the models, but if users want to use it then 
Framer is the best option. Framer is created by the same guy who created Estimator for 
SketchUp and Framer makes the work quick and easy to add wall framing into the model. 

4. Vali Instant: There is a LOT to look at here. With extensions that do everything from 
cladding to curbs, the Vali instant group of extensions adds great looking detail to the 
model. 

5. Medeek Extensions: Originally offering a truss layout tool, the extensions from Medeek 
have increased into a group of tools that will help users to frame a whole structure from 
foundation to peak. 

Source: www.blog.sketchup.com 

 

 

8 important tips to navigate Model Interiors in SketchUp 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.blog.sketchup.com/
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Modeling interior in SketchUp is a tricky job, but there are some simple tricks and tips which 
can make this tricky works easier. Justin Geis has showed them through his tutotrial. 

Justin Geis: Justin Geis is the founder of The SketchUp Essentials and started using SketchUp 
while he was working as a general contractor in 2008 and after using it he found that SketchUp 
is extremely powerful that he just started to use it in his personal works also. Then he started 
The SketchUp Essentials as a place where he could share his ideas of using SketchUp easily 
through some tutorials and tips to help other users controlling the power of 3D Modeling in 
everyday lives. 

Modeling in SketchUp is easier as the mouse works here as navigation tool that shows each 
and every corner of the model. While modeling a big house or office modeler need to view and 
control every position so that he/she can create the model as a live one. Interior design is 
actually a little bit tough job as here modeler needs to design each and every bit of a model, 
but navigating a model interior is tougher than that. Here are few tips depicted below which 
will help every modeler to navigate their models: 

1. Creating a working view: It is the easiest way to navigate a model without panning camera 
everywhere in the model, especially orbit tool works as a camera here but most of the time 
orbit tool doesn’t help to view the model properly. Creating a working view will help to 
navigate a model from top to bottom. 

2. Using a section plane to access hard to reach areas: working on other parts of a model is 
little bit tricky as user need to off all the pother layers and then focus on the layers on by 
one. While using section plane on the model will allow user to work on the hard areas easily 
and can work in all the areas in one time. 

3. Navigating with the First person camera tools: Orbit tool may help to navigate the different 
part of model but it will not deliver a crystal clear view, that’s why using the First person 
camera tools will help o navigate the views. 

4. Saving camera views for future use: saving is a great option in SketchUp, while modeling on 
the interior part it is advisable to save every little changes of camera as it will help in further 
works. 

5. Using Position Camera to set precise camera locations: It will help to go through the model 
form a fixed point and while navigating camera it will view the inner area of the model 
clearly. 

6. Setting camera height with the Look Around Tool: If user will set the Look Around Tool at a 
good height it will cover the upper locations and will give a view from the top. 

7. Using a wider Field of view to see more in space: it helps to zoom in every corner of model 
to make the model perfect. 
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8. Using Walk Around and Collision Detection to move around: These two commands help to 
walk around and move around a model which gives the user a feeling that he/she is walking 
into the model and looking every corner of it. 

Source: www.thesketchupessentials.com 

 

 

 

 

 

 

Adding background images to a SketchUp model in four 
different ways 

 
3D modeling in 
SketchUp has become 
easier with SketchUp 
and adding some 
background images to 
a SketchUp model can 
be easier using four 
different methods. 

While working with a 
SketchUp model, often 
users want to add 
some kind of 
background image 
through creating some 
kind of geographical 
context like adding an 
image of sky, 
mountains etc. In this 
article, we are going to 
tell you some other 
way to add a 
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http://www.thesketchupessentials.com/top-8-tips-for-navigating-model-interiors-in-sketchup/
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background image to the model. 

Justin Geis has explained this tutorial through his video we are just going to give you a detailed 
written description of the tutorial. 

Justin Geis: Justin Geis is the founder of The SketchUp Essentials and started using SketchUp 
while he was working as a general contractor in 2008 and after using it he found that SketchUp 
is extremely powerful that he just started to use it in his personal works also. 

Then he started The SketchUp Essentials as a place where he could share his ideas of using 
SketchUp easily through some tutorials and tips to help other users controlling the power of 3D 
Modeling in everyday lives. 

Here are four ways to add background images in the SketchUp model: 

o The first way is simple one where users just need to draw a face in the background and 
apply the background image to it. Though it is a simpler version but it is often limited to a 
few camera angles. 

o In the second method, users can add a watermark to the image; instead of adding actual 
geometry to the image users can create a watermark in the styles section of model using 
the background image. This thing will always stay behind the model though it will be a bit 
difficult to get the scene set up. 

o The third way is to create a curving background behind the model which has many benefits 
like it allows users to adjust camera angle and while rendering the model, users should get 
some reflection of the sky in the glass which make it look more realistic. 

o The last way is to download a sky dome which is basically a dome drawn in SketchUp with a 
sky material applied to it. This sky model can completely covers the model though it needs 
some UV mapping/advanced texturing to make. 

Source: www.youtube.com 

 

 

6 important things every SketchUp beginners must know 

 
SketchUp is a great tool for 3D modeling, sharing thoughts, making bonding with other users 
and most of all to learn new and different way of modeling which make a beginner a pro. 

SketchUp is a great tool for 3D printing and creating wonderful designs and models. It is free, 
handy and easy to tackle as there are lot of tools and extensions has added in this software. 
The SketchUp Extension Warehouse is full of tools that will help in every possible way to model 
the idea of user and will help to print the best 3D print. But working in it as a new user is a little 

http://www.youtube.com/
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bit challenging as 
new user can get 
puzzled of seeing 
too much features in 
it, so here is a little 
guide for them. 
There are 6 main 
tips every SketchUp 
user needs to 
remember which 
can help them 
creating their 
models in a better 
way easily. 

This article is going 
to describe those 6 
must remembered 
tips that can help 
every new beginner 
at the starting of 
their SketchUp experience. At first we will give a vast description about SketchUp and then the 
tips are described. 

6 most important tips for SketchUp beginners: 

1. Understanding the User Interface: As SketchUp is a great tool for modeling, users need to 
be fully aware about the surroundings. There will be many more involved functions can be 
found by users which are hidden from the view. There are many more things beside 
normal sketching in it like creating own custom style or adding a material library or 
exporting model to a different format which need an expert grip on the paths. While 
knowing the User Interface better, users can explore more menus and become familiar 
with features and functions which are not available in toolbars. 

2. Using more Shortcut keys: SketchUp is full of tools and extensions which are hidden in 
different area of SketchUp so it is impossible and very much time consuming to find them 
every time while following the path. Rather it is easier to remember them with their 
Shortcut keys as it is less time consuming and makes the work faster. Developing muscle 
memory is an important thing in becoming master in SketchUp as it will make work faster, 
smoother and smarter. 

3. Saving everything: Software is fickle by its nature and SketchUp is not stable to the old 
crash. So it is better to save every little thing and set SketchUp to make backup files and 
the Auto-Save must be set to at least 5 minute intervals. 
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4. Using Extensions: SketchUp is itself pretty powerful software where many tools can be 
found in toolbars for every need but besides that, there are lots of other tools in the 
SketchUp Extension Warehouse which will help to modeling a way better. 

5. Keep updated SketchUp: Working on the latest and greatest version of SketchUp makes it 
sure that users have the best chance of reducing crashes accessing new tools and being at 
the cutting edge of CAD design. SketchUp also encourages users to update for each of its 
major releases so it is sensible to use the current version at every time. 

6. Join a User Community: Starting of any unknown journey is a challenging task but 
fortunately, SketchUp has a plenty of awesome communities to share, find and discuss all 
things related to SketchUp. There are lots of people available in the SketchUp Forum or 
SketchUp Help Center all the time who will find solution of every little problem. 

Source: sketchucation.com 

 

Guide to draw Freehand Shapes 
 

SketchUp’s Freehand Tool helps to create hand-drawn lines, like the planter decorations or 
simple lines and in this article we will describe the way of drawing Freehand Shapes using 
Freehand Tool. 

There are many tools within SketchUp which are useful in creating 3D models or geometry and 
one of them is the SketchUp Follow Me Tool. It is the Pied Piper of 3D geometry that controls a 
face collaboratively a path for creating a 3D shape and it is the only thing this tool does. But it 
has a multitude of applications and enables users to draw complex 3D models with only a few 
clicks. Follow Me tool is users favorite tool as it is very handy in modeling finishing details that 
track a perimeter or edge like crown modeling or gutters and also make easier to work with 
modeling boarded objects like a spindle and curved vessels etc. 

About Freehand Tool: SketchUp’s Freehand Tool is a handy tool which will help to trace 
imported drawings, create a2D sketch and decorate models. This tool will help to create hand-
drawn lines, like the planter decorations or simple lines. This tool can be found in the following 
places: 

o Getting Started Toolbar (Click the drop-down arrow next to the Line tool) 
o Drawing toolbar 
o Large tool Set Toolbar 
o Draw > Lines submenu 

https://sketchucation.com/resources/tutorials/beginner/1779-6-things-for-sketchup-beginners
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Drawing Freehand curves or polylines: Users can draw freehand curves on existing faces or 
individual from existing (but aligned to an axes plane). Here are the steps to follow to draw a 
curve: 

o At first, users need to select 
the Freehand tool and the 
cursor will change to a pencil 
with a curve. 

o Then they need to click and 
hold the tool to place the 
beginning point of the curve. 

o Then the cursor needs to 
drag for drawing and while 
drawing, the color of the line 
matches to the axis 
perpendicular to the drawing 
plane. For creating a 
ployline, users need to hold 
down the Shift Key while 
drawing. 

o If the mouse button released 
to stop drawing then the line 
will turn black. 

Editing a Freehand curve: Users can change the length of a curve entity as long as it doesn’t 
bind a face and here are the following steps to edit a curve: 

o At first, the Move Tool is selected; it changes the cursor to a four-way arrow. 
o The cursor needs to hover over the curve to locate an end point. 
o Next the cursor needs to click and drag at the end point to adjust the curve. When the drawing 

is done, users need to release the mouse. 

Source: www.help.sketchup.com 

 Top 8 Websites for Textures and Materials for SketchUp 
3D Rendering and modeling is getting easier in SketchUp with the help of different materials 
and textures. There are different websites where SketchUp users can find their textures. 

 
Justin Geis: Justin Geis is the founder of The SketchUp Essentials and started using SketchUp 
while he was working as a general contractor in 2008 and after using it he found that SketchUp 

https://help.sketchup.com/en/sketchup/drawing-freehand-shapes
http://www.sketchup-ur-space.com/2019/august/top-8-websites-for-textures-and-materials-for-sketchup.html
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is extremely powerful that he just started to use it in his personal works also. Then he started 
The SketchUp Essentials as a place where he could share his ideas of using SketchUp easily 
through some tutorials and tips to help other users controlling the power of 3D Modeling in 
everyday lives. 

We all know that SketchUp models can be made easily with the help of textures but users can 
only download or find different SketchUp textures from SketchUp extension Warehouse. In this 
article we are going to address 8 different websites from where users can get their favorite 
textures for modeling in SketchUp. Here are the details: 

The places to find new Textures 

and Materials for SketchUp: 

o 3D Warehouse: The first place to 
find different materials is the 
SketchUp 3D Warehouse. Here 
users can find different materials 
here can download the materials 
section and use them in their 
models. 

o SketchUp Texture Club: Here 
users can log in as a free member, 
download textures and materials 
and can use them in their models. 
But for rendering the maps or 
other things it is better to be a 
member in SketchUp texture Club. 

o Textures.Com: Here users can download textures for free, logging in as a free member will 
help to download some different textures for free of cost also. 

o Texture Haven: Similar as other 3 websites, Texture Haven is also a free website where the 
textures come with different mapping options, comment sections etc. These textures are in 
very high quality and come with options to ask for fitted materials so users can easily find their 
things to use. 

o Shares Textures.Com: This website is similar as Texture Haven and includes a huge number of 
free downloaded materials and textures for SketchUp. 

o CCO Textures.Com: This website includes some cool PBR Materials and textures which are free 
of cost to download. The textures look seamless and high-quality to use. 
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o Polligon.Com: Though this site doesn’t have high-quality textures but the textures can 
definitely be used in the commercial purpose. The free textures come with different maps, 
ground materials and after signing in they can be easily downloaded. 

o Quixel Megascans: It includes a program called Mixer where users can blend different textures 
and materials together to create a new one. Besides Materials, they have a whole library of 
different contexts, textures etc. They also have a huge collection of previous used or created 
textured maps for a guidance of users. They have a certain monthly payment option for users. 

Source: www.thesketchupessentials.com 

 

PlaceMaker – A powerful sketchup extension to make 3D 

cities into models quickly 
 

Placemaker refers to a useful extension for SketchUp that can be used to create 
3D cities into your model quickly with a single mouse click. 
It fetches geographical data and generates streets, paths, buildings, bodies of 
water, and more. It is also capable of fetching high resolution map data in 
SketchUp as well as importing buildings, trees and forests. 

Placemaker also allows for importing OpenStreeMap roads, buildings, paths, 
water bodies, trees, as well as high resolution aerials and transferring these to 
functional site reference model ideal for rendering or exporting into other 
applications. 
This sketchup plugin is well suited with SketchUp 2016, SketchUp 2017, SketchUp 
2018, SketchUp 2019 as well as AutoCAD, Revit, 3ds Max, Rhinoceros, Bentley and 
Lumion. 

The followings are some exclusive features of the plugin :- 

Imagery - Mapbox and Nearmap 

It can import up to 2.8" (7cm) high resolution aerials directly into SketchUp. 

3D Buildings 

It can quickly import numerous real 3D building massing models for select 
locations and cities. 

http://www.thesketchupessentials.com/top-8-websites-for-textures-and-materials-for-sketchup/
http://bit.ly/SuPlaceMaker
http://bit.ly/SuPlaceMaker
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Trees and Forests 

With a single mouse click, it can import 3D Forest for different locations and areas. 

Roads and Paths 

Arrange 3D roads, walks, paths and water into your model. All objects are 
modeled and render ready. 

Model on Terrain 

Placemaker can 
model and drape 
buildings, 3D roads 
and paths directly 
to terrain. 

Building Bundle 

It comprises of 
more than 300 
detailed building 
components. 

Export to Revit 

With the use of 
export to Revit function, it can import your model into Revit. 

Instant Site Base 

It can generate instant site base files to be utilized for modeling, design and 
rendering. 
To download PlaceMaker, click on the following link 
 
 

Create Smart Building Automatically with Profile Builder 
 

Profile Builder 3 is a useful sketchup extension that can be applied to produce smart buildings 
automatically with skin, columns, beams, and more. Profile Builder can also be used to 
reiterate components and extrude profiles with the purpose of generating buildings, walls, and 
other objects in SketchUp. 
 

http://bit.ly/SuPlaceMaker
http://bit.ly/SuPlaceMaker
http://bit.ly/ProfileBuilder3
http://bit.ly/SuPlaceMaker
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Profile Builder is compatible with SketchUp 2016, SketchUp 2017, SketchUp 2018, SketchUp 
2019. 

Profile Builder is considered as a rapid and compliant set of parametric modeling tools for 
SketchUp. Profile builder facilitates the users to accelerate their modeling speed significantly. 
Besides, the models become smarter and adjustable to all the design modifications. 

Profile Builder has similarity with Follow Me tool. Profile Builder comprises of an extensive 
library of pre-configured and custom profiles to extrude which can be repurposed on every 
project. Your own profiles can also be made and saved to the library. 

Profile Builder is user-friendly and the users can adjust how they require the profile to be 
extruded by modifying its offsets, scale, and orientation along the path. 

The most updated version of Profile Builder is 3.0.5 that contains some vital bug-fixes and 
usability enhancements. The built-in sample assemblies are also upgraded. 
Assembler elaborates on the functionality of Profile Builder by extruding numerous profiles in 
one step. Assembler will be able to add pre-configured components together with extruded 
path at set intervals. It is ideal for fences, stairs, railings, etc. 

Click Here to Try Profile Builder 3 OR Get a Full License 

 

 
 
 

http://bit.ly/ProfileBuilder3
http://bit.ly/ProfileBuilder3
http://bit.ly/ProfileBuilder3
http://bit.ly/ProfileBuilder3
http://bit.ly/ProfileBuilder3

